f(?w LexisNexis

| ex|s’
Create+

Microsoft® Word Add-in




f(ﬁm LexisNexis

Table of
Contents

INTRODUCTION
REQUIREMENTS

Version Checking

3
3
4
DEPLOYMENT 4
Deployment from the Microsoft Store 4
Centralized Deployment from Microsoft Admin Center 4
STEPS FOR MICROSOFT 365 ADMIN CENTER 5
USING CUSTOM AUTHENTICATION FOR THE APPLICATION (SAML) 14

CREATING A CUSTOM MANIFEST FILE FOR SAML AUTHENTICATION FOR GLOBAL CREATE+ PLATFORM 15

Requirements 15
Configure SAML authentication for Global Create Platform Customer 15
Update the SourcelLocation in the Manifest 16
Update the Taskpane.Url in the Manifest 16
Screenshot 16

f(a’ LexisNexis’ LexisNexis Proprietary INSTALL GUIDE 2



INTRODUCTION

This document describes the install process for the Lexis® Create+ Microsoft® Word Add-in.

REQUIREMENTS

« Users need to have the Microsoft Word Desktop installed on their machine.
« The Administrator needs access to the Microsoft admin center.
« The end user system requirements are:

Computer and processor:

»  Windows OS: 1.6 GHz or faster, 2-core

» macOS: Intel processor

Memory:

»  Windows OS: 4 GB RAM

» macOS: 4 GB RAM

Hard disk:

»  Windows OS: 4 GB of available disk space

» macOS: 10 GB of available disk space; HFS+ hard disk format (also known as macOS
Extended) or APFS

Microsoft Word: Office 365 required.

Compatible Microsoft Office versions: 32-bit, 64-bit [INOTE: While 32-bit is supported, it can
impact the performance of the add-in. 64-bit is recommended.]

Display:

»  Windows OS: 1280 x 768 screen resolution (32-bit requires hardware acceleration for 4K
and higher)

» macOS: 1280 x 800 screen resolution
» Web apps require the same minimum resolution as the OS they are running on.

» Minimum resolution assumes zoom, DPI settings, and text scaling are set at 100%. If not
set to 100%, minimum resolution should be scaled accordingly. For example, if you set the
Windows display ‘scale and layout’ setting on your Surface Book, which has a 3000x2000
physical display, to 200%, then Office would see a logical screen resolution of 1500x1000,
meeting the minimum 1280x768 requirement.
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Graphics

»  Windows OS: Graphics hardware acceleration requires DirectX 9 or later, with WDDM 2.0
or higher for Windows 10 (or WDDM 1.3 or higher for Windows 10 Fall Creators Update).

» macOS: No graphics requirements.

On the network side, the software needs to connect to the internet, by default, it will attempt to use
your system settings in the Control Panel. Please ensure that traffic for https:/pdclc-maximusimo.
globalplatform.route53.lexis.com/ is allowed on your network.

Version Checking

To determine your version of Word, open the File menu in Word, then Account, then About Word.
The version will appear in the first line of the About Microsoft Word dialog. In Microsoft Windows
on newer versions of Office you can type Control-C to copy this information to share with others
more readily.

To determine if you have the latest Office updates for your software, first check Windows Update
settings by going to the Settings app, then select Windows Update (or Updates and Security). You
should see when the last check was made and the phrase “You're up to date” on this application. Next,
in Word, open the File menu, then Account. Next to the Update Options button is a description of the
update status for your software. If your updates are managed by your organization, you will need to ask
your system administrator if your system is up to date.

DEPLOYMENT

There are two methods of deployment: through the Microsoft Store and through the Microsoft
Admin Center.

Deployment from the Microsoft Store
Install directly from the Microsoft Store:
https:/appsource.microsoft.com/en-us/product/office/WA200004714

Centralized Deployment from Microsoft Admin Center
Reference https:/docs.microsoft.com/en-us/office/dev/add-ins/publish/centralized-deployment

We recommend using these options for deployment of the LexisNexis Add-In: AppSource, Microsoft
365 Admin Center or SharePoint catalog.
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STEPS FOR MICROSOFT 365 ADMIN CENTER

1. Log in to Microsoft Admin Center.
2. In the Admin center please go to Settings > Integrated apps > Add-ins page.

- Mome » Integeated apps ) Dark made

i Integrated apps

R wen v

Dsceve, purchare, scaube, monay , 203 o » 20 eviey mnd B 1.008 s desioped wahn yous © .
W Toame b vt v 7ot sovanced mansgement of these 4591 90 15 INE rEADECtVE SdmIn Center Of DIGE - ATt At Srarburt | feom m —— Chck here
A Rl v
D ———
B Rerewins
2 smey G P T L L ——,
C supen v Pt i 10 e deployed A~
@ semngn ~
L) Mo tor Miroson .. () oteTwo tor Outook g Silertore
Comant sow . - a -
R ORI ——— [ —
ot aind - ™ o 0gs dermmen & motemy o/ e Somvers Pariven o Crvinan

Oug semtingy
Vew etan View aetan View aetats
| integrated sppr

Fataer rewtionios

2 see "

K hesorts v

@ oot % HGetaen ¥ Upioss amtom apps ) Reresn otemi 7 pner [ 0 sewer

A oty e ot s s Tow dm iyt Lt odeies |
@ Securny

@ Complance

Lo tnapent Mansge

@ Anure Atwe Dreet.

@ oene  Gma
LR

€ e
B A sawin contens
Show pinned

3. Click on Deploy Add-In

C &  hitps//admin.microsoft.com/Adminportal/Home#/Settings/Addlns A O N Q0 8 T @ ¥ 1\

Home J) Enable Dark mode

Deploy a new add-in

The Centralized Deployment service lets you deploy Microsoft 365 Web add-ins to users of Excel, Outlook, PowerPoint and Word.

Learn more about the requirements for Centralized Deployment.

Adgins deploy the cally pdates as the providers continuously improve their service. If an add-in update significantly
ncresses the scope of deta sccess, you must re-spprave #t before the update is deployed.

Cancel

(@“‘ LexisNexis LexisNexis Proprietary INSTALL GUIDE 5



4. If the add-in was published using an XML file provided by the IT team, then choose Upload
custom apps option. If it was deployed from the Store, select the option Choose from the Store.
Note that, the latter option can be used only when the add-in you want to deploy is already
available in the Store.

G © hipeifadminmicrosoconyAdminportaHomatSetingdAddi Ao N O G DT B B \\

Home J) Enable Dark mode

Deploy a new add-in

Deploy from the Store
Get solutions tailored to your industry that work with the products you aready use.

Choose from the Store
Deploy a custom add-in
Create 3 new web appiication, or upload an addvin / integration for Microsoft 365.

Upload custom apps

Cancel

5. Deploy Add-In

In this example, we are going with the option “Upload custom apps”. Click on Choose Files
button to browse the location of the manifest file to upload it.

C O nhupsy ft. J sf A N O Q8 B v @ | - @

i Microsoft 365 admin center

Deploy a new add-in
Choose how to upload the add-in

(®) 1 have the manifest file (xmi) on this device

Choose @ No fie chosen

(O 1 have a URL for the manifest file

Upload Cancel
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6. Once the upload is successful, we should see the “Configure Add-in” screen. Administrators can

deploy it to Everyone / specific groups as shown below.

C B nttpsy:

i Microsoft 365 admin center

7. Click on the Deploy button.

Configure add-in

LexisNexis®

0- By LexisNexis®

Assign Users

Choose which users will have access o LexisNexis®

O tveryone
(®) Specific users / groups.

Search for specific users or groups to sdd or remove

® g

I Microsoft 365 admin center

Configure add-in

LexisNexis®

O- By LexisNexis®

Assign Users

Choose which users will have access 1o Lexishexis
(O tveryone
(®) Specific users / groups.
Sesich for specific users or groups to 8dd or remove

® e
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Microsoft 365 admin center £ search

Deploy LexisNexis®

() Getingyouratinressy. his might ke fow mintes

You will receive an email notification confirming your successful deployment.
Users might need to relsunch Microsoft 365 to see the add-in icon in the ribbon.

8. LexisNexis Word Add-In is successfully deployed to the end users within your organization.

G O hpsr v /AT TN U YT 8w

Microsoft 365 admin center L search

Deploy LexisNexis®

(@ Your add-in has been deployed

You will receive an email notification confirming your successtul deployment.
Users might need to relaunch Microsoft 365 to see the add-in icon in the ribbon.

Get started with the add-in

To test deployment is successful. launch Word from the icons below to confirm the add-in is present on the ribon.

Next Close
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Test it from the Word application

1. Now open the Word application and sign in to your account and click on the “Add-ins” button in
the ribbon on the Home menu and we should be able to see our add-in that was just deployed.
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The add-in store r&g been disabled. Please turn
on the “optional connected experiences”
setting through your File > Account > Account
Privacy or contact your IT administrator for
more information.
Learn how to enable the Add-ins store.
Tets Text Precictizns On &) hdd-ins losded surcessfully. CglDispiapSetting:s Dikons B B B —— 1 +/w)

Note: The steps documented above are in line with the Microsoft website and may be subject to

change and updates. The link can be found here: https:/learn.microsoft.com/en-us/microsoft-365/
admin/manage/manage-deployment-of-add-ins?view=0365-worldwide
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Updating an add-in via Microsoft 365 admin center

1. Sign in to Microsoft 365 Admin Center. Click on Settings >> Integrated Apps and then click on

Add-ins as shown below.
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Ok
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3. Click on the “Update add-in” link available at the bottom right corner shown below

C @  https//admin.microsoft.com/Adminportal/Hon

i Microsoft 365 admin center

Edit LexisNexis®

LexisNexis® Privacy Policy
‘ Version 1.020 Terms of Use
Get Help
Host Apps: Word

LexisNexis® add-in loaded succesfully. Go to the HOME tab and click the
LexisNexisS button to get started.

Assign Users
Choose which users will have access o LexisNexs ®
O everyone

(®) Specific users / groups
Search for specific users or groups to add or remove

[ Start typing a name to search for users

4. Upload the add-in or enter the URL of the manifest file to upload

C https//admin.microsoft.com/Adminportal/Home#/Settings/Addlns

Update LexisNexis®

Choose how to upload the add-in

(®) | have the manifest file (xml) on this device

Choose File No file chosen

(O I have a URL for the manifest file

Update Cancel
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Update Cancel

C 3  https//admin.microsoft.com/Adminportal/Home#/:

Microsoft 365 admin center

ings/Addins

£ search

Edit Lexis® Create+

Updated Successfully

Privacy Policy
Terms of Use
Help

Lexis® Create+
Version 1.0.5.0

Host Apps: Word

Lexis® Create+ delivers a powerful. personalized legal drafting experience in
Microsoft 365. Go to the HOME tab and click the Lexis® Create + button to get
started.

Assign Users
Choose which users will have access to Lexis® Create+
O Feveryone
(®) Specific users / groups
Search for specific usars o groups to 3dd or remoue

Ean typing a name to search for users

Sates @

Save Close
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5. Verify the updated add-in. Go to Home menu and click on the Add-ins button and go to the
“‘Admin managed” tab and click on the Refresh button available on the top right corner. This
should refresh our add-in, and the newly updated add-in should show up.
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USING CUSTOM AUTHENTICATION FOR THE APPLICATION (SAML)

The following is for internals (CSIC and Customer Support) only. If the Choose from the Store
option is not available for your organization, then please use the steps below after Step 3 above

instead. The use of a custom application file will prevent automatic updates to this file on users’
machines compared to using the store.

1. Select Upload Custom apps.

Deploy a new add-in

2. Choose File in Deploy a new add-in. Select the manifest file provided by CSIC or CS.

Deploy a new add-in
Choose how 1o upload the add-in

(®) | have the manifest file (xmi) on this device

Choose File No file chosen

(O I have & URL for the manifest file
| hitps//

J

((im LexisNexis LexisNexis Proprietary INSTALL GUIDE 14



3. Click on Upload. This will Create+ the entry for the add-in.
4. Click on the add-in to configure.

Configure add-in

y Lexis® Privacy
/(( Contoso

Assign User

Choose which

By
ich users will have access to Lexis® Privacy

() tveryone
(®) Specific users / groups

Search for specific Users or Groups 1o add of remove

[
© st~
() Justme

Deployment Method
() Fixed (Detavivy
The add-in will be sutomatically deployed to the assigned users and they will not be able to

5. Please select the option that best suits your business needs.

GLOBAL CREATE+ PLATFORM

Requirements

For setting up SAML for authentication instead of the standard Lexis Sign-in, a federation ID will
have to be set up with the authentication team at saml/sso@lexisnexis.com. A sample federation ID
is shown below for quick reference.

Example - 94B3HW5070

Configure SAML authentication for Global Create+ Platform Customer
1. Please get the latest manifest.
2. Update the source URL in the manifest.

The general URL structure is:

<WAM _SIGNIN_URL> + <Application_URL> + %2F%3F + federationidp%3D + <Federation_ID>
+ &amp;aci=gp

For example
https:/signin.lexisnexis.com/Inaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximusimo.
globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp;aci=gp

3. Load the manifest in the Word application using the deployment steps mentioned above.
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Update the SourceLocation in the manifest

<!-- The URL that gets called when we click on the Icon in the ribbon, basically the starting URL -->

<DefaultSettings>

<Sourcelocation

DefaultValue="https://signin.lexisnexis.com/Inaccess/app/
signin?back=https%3A%2F%2Fpdclc-maximusimo.globalplatform.route53.lexis.
com%2F%3Ffederationidp%3D94B3HW5070&amp;aci=gp”/>
</DefaultSettings>

Update the Taskpane.Url in the manifest

<bt:Url id="Taskpane.Ur!” DefaultValue="https:/signin.lexisnexis.com/Inaccess/

app/ signin?back=https%3A%2F%2Fpdc1c-maximusimo.globalplatform.route53.lexis.
com%2F%3Ffederationidp%3D94B3HW5070&amp;aci=gp”/>

Screenshot

The following screenshot shows the two places in a sample manifest file where we need to update

the URL to use the federation ID to enable SAML authentication for the customer.

"1.0" encoding="UTP-8" standalone="yes"?>

lns="http: [{s:hemﬂu microsoft. cm[uli::e[lpgturuffica[l.l"

"http: //‘nnhnmu microsoft. cnn/n:ncn/ntncuppbanctypon/l.u"
"http://dchemas microseft, com/office/taskpaneappveraicnoverrides” x5i:type="TaskPaneApp":

<Version>1.0.0.4</Version>
<ProviderName>LexisNexis®</FroviderNames

L.:xumnxuw />
E="LexisNexis® add=in loaded succesfully. Go to the HOME tab and click the LexizNexis® button te get started."/>
~ui-lmo-create.globalplatform.route53.lexis.com/assets/Icon-LexisNexis-32.png"/>

<IconUrl Defl
13 <HighResolutionlconUrl D
14 <SupportUrl DefaultVal

| <!-- List of dar
| <AppDomaings

of application we want to support --3

—- The URL that gets called when we click on the Icon in the ribbon, basically the starting URL -->
| <nefau1t;=tt1nuss

<Sourcelacation DefaultValue=
"httpa://signin. lexisnexis.com/lnaccess/app/signintback=httpat3A42Fi2Fpdele-maximuslme . globalplatform. routass . lexds, comi2F 3Ffaderationidp)3D94B3RWS0T705amp acimgp /=
</DefaultSettings>
i Read Write permissions for our add-in -->
>ReadWritaDocumant /P izzion=>
Ed <versionoverrides xmins="http://schemas micresoft,com/office/taskpaneappversionoverrides” xsiitype="VersienoverridesVl 0'>
51 [H__ <Hosts>
83 ] Resourcess
84 =, ¢bt: Image
1 =] ‘ht:Url
1 <bt:Url id="GetStarted.learnMereUrl" Dofa \N lus="httpa://go.miereseft. com/Ewlink/?LinkIdm276812" />
102 i="Commands .Url" DefaultVall -”hbt clc-gp-ui-lmo-create.globalplatform. route53 . lexis.com/commands . html"/>
| " ://zigni snexiz.com/lnaccess app/signin?back=https$3A%2Fi2Fpdcic-: 1mo.globalplatform. routeS3.lexis.comb2Fs onidp3DI4BIAWE0T0kamp; aci=gp" />
4
1 H t8tringss
11 kil strings>

=>
</VersionOverrides
</otticeRpp>

LexisNexis.com/lexis-create+ 7~ % . -
@ LexisNexis

Contact a LexisNexis representative for more information

Lexis, LexisNexis, the Knowledge Burst logo, Shepard’s, and Lexis+ are registered trademarks of RELX Inc. Microsoft is a
trademark of the Microsoft group of companies. DocuSign is a registered trademark of DocuSign, Inc. Other products or
services may be trademarks or registered trademarks of their respective companies. © 2025 LexisNexis.


https://signin.lexisnexis.com/lnaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximuslmo.globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp%3Baci=gp
https://signin.lexisnexis.com/lnaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximuslmo.globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp%3Baci=gp
https://signin.lexisnexis.com/lnaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximuslmo.globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp%3Baci=gp
https://signin.lexisnexis.com/lnaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximuslmo.globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp%3Baci=gp
https://signin.lexisnexis.com/lnaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximuslmo.globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp%3Baci=gp
https://signin.lexisnexis.com/lnaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximuslmo.globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp%3Baci=gp
https://signin.lexisnexis.com/lnaccess/app/signin?back=https%3A%2F%2Fpdc1c-maximuslmo.globalplatform.route53.lexis.com%2F%3Ffederationidp%3D94B3HW5070&amp%3Baci=gp
https://www.LexisNexis.com/lexis-create



